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Installing Pro Tools | Software
Welcome to Pro Tools® | Software from Avid. This

guide explains how to install and authorize

Pro Tools software on Mac and Windows systems.

For detailed information on configuring your

Pro Tools system, and for complete information

about Pro Tools system capabilities and functional-

ity, see the Pro Tools Reference Guide (available

from the Help menu in Pro Tools).

There are two types of Pro Tools software:

Pro Tools HD

Pro Tools | HD Software can be used with the fol-

lowing hardware:

• Pro Tools | HDX hardware for expanded I/O,

low latency monitoring, and dedicated DSP for

plug-in processing and large mixer configura-

tions

• Pro Tools | HD Native hardware for expanded

I/O and low latency monitoring

• Avid 003™ family, Pro Tools | Eleven® Rack,

Pro Tools | Mbox® (3rd generation), and

Pro Tools | Fast Track® hardware

• Third-party audio hardware with supported Core

Audio (Mac) or ASIO (Windows) drivers,

including built-in audio hardware on Mac com-

puters
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Pro Tools

Pro Tools software can be used with the following

hardware:

• Avid 003 family, Eleven Rack, Mbox (3rd gener-

ation), and Fast Track hardware

• Third-party audio hardware with supported Core

Audio (Mac) or ASIO (Windows) drivers,

including built-in audio hardware on Mac com-

puters

System Requirements and 
Compatibility
The following are required to install and authorize

Pro Tools software:

• A DVD drive (if you purchased a boxed version

of Pro Tools with an installer disc)

• An Internet connection (to download the

Pro Tools installer and Pro Tools authorization)

The following are required to run Pro Tools soft-

ware:

• A qualified Windows or Mac computer

• A qualified audio interface (or built-in audio ca-

pability)

• An iLok USB key (2nd generation) to authorize

Pro Tools software

For a list of qualified audio interfaces and
computers for all Pro Tools systems, visit
www.avid.com/compatibility.
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Avid can only assure compatibility and provide

support for hardware and software it has tested and

approved. For complete system requirements and a

list of qualified computers, operating systems, hard

drives, and third-party devices, visit

www.avid.com/compatibility.

About iLok
Pro Tools software is authorized using an iLok

USB key (2nd generation) from PACE Anti-Pi-

racy. An iLok can hold hundreds of authorizations

for all of your iLok-enabled software. After a soft-

ware license is placed on an iLok, you can use the

iLok to authorize that software on any computer.

• If you purchased a boxed version of Pro Tools, or

Avid hardware bundled with a version of

Pro Tools or Pro Tools HD software, it includes

an iLok USB key (2nd generation) and an

activation card with a printed activation code.

• If you are upgrading from a previous version of

Pro Tools or Pro Tools HD software, you will

need to use your own iLok USB key (a 2nd gen-

eration iLok is required). You will receive an

activation code through your online Avid ac-

count.

MIDI Requirements
USB, FireWire, and PCI MIDI interfaces work ef-

fectively with Pro Tools systems on Mac or Win-

dows.

Hard Drive Requirements
For optimal audio recording and playback, all

Pro Tools systems require one or more qualified

hard drives.

iLok USB key (2nd generation)
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Avoid Recording to the System Drive

Recording to your system drive is allowed, but not

recommended. Recording and playback on a sys-

tem drive may result in lower track counts and

fewer plug-ins.

Installation Overview
Installation of Pro Tools includes the following

steps:

1 “Creating Your Avid Account” on page 3.

2 “Retrieving Your Pro Tools | Software License”

on page 3.

3 “Removing Previous Versions of

Pro Tools | Software” on page 3.

4 “Installing Hardware Drivers” on page 3.

5 “Installing Pro Tools | Software” on page 3.

6 “Starting Up or Shutting DownYour System” on

page 4.

7 “Launching and Authorizing

Pro Tools | Software” on page 5.

8 Configuring your system for improved perfor-

mance.

For optimum performance, you may want to
designate your system drive as a Playback or
Transfer volume in the Pro Tools Workspace.
For more information, see the Pro Tools Ref-
erence Guide.
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Creating Your Avid Account
An Avid account is required to activate Pro Tools

software, and, if you purchased a download version

of Pro Tools, to download your software.

 If you don’t have an Avid account, visit

www.avid.com/myavid to create your account.

Retrieving Your 
Pro Tools | Software License
When you purchase Pro Tools, you receive an acti-

vation code, either on an activation card or through

your Avid account.

To retrieve your Pro Tools software license:

1 If you don’t already have an iLok account, visit

www.ilok.com to sign up for an account.

2 Visit www.avid.com/activation and log into your

Avid account (if you don’t already have an Avid

account, click “Create Your Account”).

3 Enter your activation code and your iLok.com

User ID.

4 Follow the on-screen instructions to deposit

your license into your iLok.com account.

Removing Previous Versions 
of Pro Tools | Software
If you have a previous version of Pro Tools in-

stalled, remove it according to the instructions in

the Installation Guide for that version.

It is possible to have Pro Tools 10.3.6 or higher
installed at the same time as Pro Tools 11. Visit
www.avid.com/compatibility or see the
Pro Tools Read Me for details.
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Installing Hardware Drivers
Before installing Pro Tools software, install the lat-

est drivers for that hardware. Refer to the documen-

tation that came with your audio hardware for more

information. For Avid audio interfaces, download

and install the drivers for your Avid hardware from

www.avid.com/drivers.

Installing 
Pro Tools | Software
After you have installed the drivers for your audio

interface, you are ready to install Pro Tools.

Installing Pro Tools on Mac

To install Pro Tools on Mac:

1 Do one of the following:

• Insert the Pro Tools Installer disc into the DVD

drive on your computer.

• Download the Pro Tools Installer from your on-

line Avid account.

2 Open the Pro Tools disc or disk image.

3 Double-click Install Pro Tools 11.3.pkg.

4 Follow the on-screen instructions to continue in-

stallation.

5 Once the installation is complete, click Close.

Pro Tools will not recognize your audio inter-
face if you do not install the drivers. If you are
upgrading Pro Tools, be sure to install the lat-
est drivers for your hardware.

Before installing Pro Tools, refer to the
Pro Tools Read Me included with the installer.
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Installing Pro Tools on Windows

To install Pro Tools on Windows:

1 Make sure you are logged in as an Administrator

for the account where you want to install

Pro Tools.

2 Do one of the following:

• Insert the Pro Tools Installer disc in your DVD

drive.

• Download the Pro Tools Installer from your on-

line Avid account.

3 Do one of the following:

• If Windows AutoRun is enabled, a mini-browser

appears. Select Install Pro Tools to begin installa-

tion.

• If Windows AutoRun is disabled, locate and dou-

ble-click Setup.exe, and then select Install

Pro Tools to begin installation.

4 Follow the on-screen instructions to continue in-

stallation.

5 When the Install Wizard is done, click Finish.

Starting Up or Shutting Down 
Your System
To ensure that the components of your Pro Tools

system communicate properly with each other,

start them in a particular order.

On Windows, if the User Account Control dia-
log appears, click Allow. Several messages
are displayed during installation that can be
ignored, including multiple “Found New
Hardware” dialogs and “A Problem Oc-
curred During Hardware Installation.” If you
get a warning dialog about the driver not
passing Windows Logo testing, click Continue
Anyway.
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Start up your Pro Tools system in this order:

1 Make sure all your equipment (including your

computer) is off.

2 Lower the volume of all output devices in your

system.

3 For systems with an expansion chassis, turn on

the chassis.

4 Turn on any external hard drives. Wait ten sec-

onds for them to spin up to speed.

5 Turn on any control surfaces.

6 Turn on any MIDI interfaces and devices, or

synchronization peripherals.

7 For systems requiring external power, turn on

the hardware (such as HD I/O or 003). Wait at

least fifteen seconds for the audio interface to

initialize and the status LEDs to stop flashing.

8 Turn on your computer.

9 Launch Pro Tools (see “Launching and Autho-

rizing Pro Tools | Software” on page 5).

Shut down your Pro Tools system in this order:

1 Quit Pro Tools (on Mac: Pro Tools > Quit, or on

Windows: File > Exit).

2 Turn off or lower the volume of all output de-

vices in your system.

3 Turn off your computer.

4 For systems that use hardware requiring external

power, turn off the hardware.

5 Turn off your Pro Tools audio interfaces.

6 For systems with an expansion chassis, turn off

the chassis.

7 Turn off any MIDI interfaces, MIDI devices, or

synchronization peripherals.

8 Turn off any control surfaces or worksurfaces.

9 Turn off any external hard drives.
4



Launching and Authorizing 
Pro Tools | Software
To launch and authorize Pro Tools software:

1 Make sure your audio interface is connected to

your computer and powered on.

2 Make sure your iLok (2nd generation) is con-

nected to an available USB port on your com-

puter.

3 Do one of the following:

• On Mac, double-click the application icon in

Macintosh HD/Applications/Pro Tools.

• On Windows, double-click the Pro Tools short-

cut on the desktop (or double-click the

application in Program Files\Avid\Pro Tools).

4 When the Pro Tools activation screen appears,

click Activate.

5 Log into your iLok.com account. (If you don’t

have an iLok account, click Create New Ac-

count.)

6 When the list of available licenses appears, se-

lect the license for Pro Tools 11 and click Next.

7 Select your iLok as the location for the license

and click Next.

8 After activation is complete, click Continue to

launch Pro Tools.

Do not remove the iLok while launching or
running Pro Tools.
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Configuring Your Pro Tools 
System
After you have installed, authorized, and launched

Pro Tools software, you can configure your

Pro Tools system to meet the specific needs of your

studio. For detailed information on configuring

your Pro Tools software, see the Pro Tools Refer-
ence Guide (available from the Help menu in

Pro Tools).

Optimizing a Mac System for 
Pro Tools | Software
To ensure optimum performance with Pro Tools,

configure your computer first.

Before configuring your computer, make sure you

are logged in as an Administrator for the account

where you want to install Pro Tools. For details on

Administrator privileges in Mac OS X, see your

Apple OS X documentation.

For a complete list of recommended optimiza-
tions for your operating system, visit
www.avid.com/optimize.

Do not use the Mac OS X automatic Software
Update feature, as it may upgrade your system
to a version of Mac OS that has not yet been
qualified for Pro Tools. For details on quali-
fied versions of Mac OS, visit
www.avid.com/compatibility.
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Turning Off Energy Saver

To turn off the Energy Saver feature:

1 Choose System Preferences from the Apple

menu.

2 Click Energy Saver.

3 Set the Computer Sleep setting to Never.

4 Set the Display Sleep setting to Never.

5 Deselect “Put the hard disk(s) to sleep when

possible” option.

Disable or Reassign Mac Keyboard 
Shortcuts Used by Pro Tools

To have the full complement of Pro Tools key-

board shortcuts, you need to disable or reassign

conflicting Mac OS X Keyboard Shortcuts in the

Apple System Preferences.

To disable or reassign Mac keyboard shortcuts

used by Pro Tools:

1 From the Apple menu, choose System Prefer-

ences.

2 Click Keyboard.

3 Click the Keyboard Shortcuts tab.

4 You can disable or reassign Mac OS keyboard

shortcuts that conflict with Pro Tools keyboard

shortcuts. The following list includes several

common Mac keyboard shortcuts that, depend-

ing on the make and model of your Mac, may

also be used by Pro Tools:

• Under “Launchpad & Dock”

• “Turn Dock Hiding On/Off”

• Under “Mission Control”

• “Mission Control”

• “Application windows”

For a complete list of Pro Tools keyboard
shortcuts, see the Pro Tools Shortcuts Guide
(Help > Pro Tools Shortcuts).
Installing Pro Tools | Software
• “Show Desktop”

• “Show Dashboard”

• “Mission Control > Move left a space”

• “Mission Control > Move right a space”

• “Mission Control > Switch to Desktop n”

• Under “Keyboard & Text Input”

• “Turn keyboard access on or off”

• “Move focus to the window drawer”

• “Move focus to the Dock”

• “Move Focus to active or next window”

• Under “Services”

• “Send File To Bluetooth Device”

• “Search With Google”

• “Spotlight”

• Under “Spotlight”

• “Show Spotlight search field”

• “Show Spotlight window”

• Under “Accessibility”

• “Zoom”

• “Contrast”

• Under “Application Shortcuts”

• “Show Help menu”

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, en-

able journaling.

To enable journaling:

1 Launch the Disk Utility application, located in

Applications/Utilities.

2 Select the volume in the left column of the Disk

Utility window.

3 Select Enable Journaling in the toolbar.
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Optimizing a Windows 
System for 
Pro Tools | Software
To ensure optimum performance with Pro Tools,

configure your computer before using Pro Tools

hardware and software.

Before configuring your computer, make sure you

are logged in as an Administrator for the account

where you want to install Pro Tools. For details on

Administrator privileges, see your Windows docu-

mentation.

Required Optimizations

To ensure optimum performance with Pro Tools,

configure the following settings before using

Pro Tools hardware and software.

Disabling User Account Control
To disable User Account Control (UAC):

1 Choose Start > Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click on Change User Account Control settings.

5 Set the slider to Never Notify.

6 Click OK.

For a complete list of recommended optimiza-
tions for your operating system, visit
www.avid.com/optimize.

When you are finished changing Windows sys-
tem settings, restart your computer.
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Configuring System Standby and Power 
Management

When using Pro Tools, the Windows System

Standby power scheme must be set to Always On.

This prevents long record or playback passes from

stopping due to system resources powering down.

To configure Windows Power Management:

1 Choose Start > Control Panel.

2 Click on System and Security.

3 Click Power Options.

4 Click on the arrow to Show Additional Plans.

5 Select High Performance.

6 Click Change plan settings.

7 Click Change advanced power settings.

8 In the Power Options dialog, reveal Hard disk >

Turn off hard disk after.

9 Click Setting option.

10 Select the value in the Setting (Minutes) field

and press Backspace on your computer key-

board or scroll the value to Never.

11 Click OK. The hard disk setting changes to

Never and the Power Options dialog closes.

12 In the Edit Plan Settings window, click Save

changes and close the window.

Pro Tools automatically switches to the “High
Performance” Power Management settings on
launch. Windows reverts to the previously se-
lected Power Management settings (if differ-
ent) when exiting Pro Tools. Consequently,
when optimizing the Power Management set-
tings for Pro Tools, you should always only
optimize the High Performance configuration.
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Recommended Optimizations
Pro Tools can also be affected by other software

and hardware drivers installed on your computer.

For best possible performance, it is recommended

(but not required) that you do the following:

• Avoid running any unneeded programs at the

same time as Pro Tools.

• Turn off any software utilities that run in the

background, such as Windows Messenger,

calendars, and disk maintenance programs.

• Turn off any non-essential USB devices while

running Pro Tools.

Optional Optimizations
The following system optimizations may help

Pro Tools perform better on some systems. It is rec-

ommended that you only try these optimizations if

necessary, as they may disable or adversely affect

the functionality of other programs on your system.

Adjusting Processor Scheduling

To adjust Processor Scheduling performance:

1 Right-click Computer and choose Properties.

2 Click Advanced system settings.

3 Under the Performance section, click the Set-

tings button.

4 In the Performance Options window, click the

Advanced tab.

5 Under the Processor Scheduling section, select

the Background Services option.

6 Click OK to close the Performance Options win-

dow.

7 Click OK to close the System Properties win-

dow.
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Disabling System Startup Items

The fewer items in use by your computer, the more

resources are available for Pro Tools. Some startup

applications may be consuming unnecessary CPU

resources, and can be turned off.

If you disable any of the following startup items, do

so carefully:

• Portable media serial number (required for some

applications that utilize a copy protection key)

• The Plug and Play service

• Event log

• Cryptographic services

To Disable System Startup Items:

1 From the Start menu, type “msconfig” in Start

Search and press Enter to open the System

Configuration Utility.

2 Under the General tab, choose Selective Startup.

3 Deselect Load Startup Items and click OK.

4 Click Restart to restart the computer.

5 After restarting, the computer displays a System

Configuration message. Check to see if

Pro Tools performance has increased before you

deselect the “Don't show this message again”

option. If performance has not changed, run

“msconfig” and return your computer Startup

Selection back to Normal Startup - load all de-

vice drives and services. Alternatively, try dis-

abling Startup items and non-essential processes

individually.

Backing Up Your System
After setting up your system and installing

Pro Tools, you should save an image of your sys-

tem drive using a backup utility. By doing this, you

can quickly restore your system configuration and

settings if you encounter any problems.
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Installation du logiciel Pro Tools | Software
Bienvenue dans le guide d'installation du logiciel

Avid Pro Tools® | Software. Ce guide présente la

procédure d'installation et d'activation de votre

logiciel Pro Tools sur les systèmes Mac et Windows.

Pour obtenir des informations détaillées et

exhaustives sur la configuration, les fonctionnalités

et possibilités de votre système Pro Tools, reportez-

vous au Guide de référence Pro Tools (accessible à

partir du menu Help de Pro Tools).

Il existe deux types de logiciel Pro Tools :

Pro Tools HD

Le logiciel Pro Tools HD peut être utilisé avec le

matériel suivant :

• Matériel Pro Tools | HDX pour des E/S

étendues, un monitoring à faible latence et des

DSP dédiés pour le traitement de plug-in et les

configurations de mixage importantes

• Matériel Pro Tools | HD Native pour des E/S

étendues et un monitoring à faible latence

• Interfaces Avid de la famille 003™, Eleven®

Rack, Mbox® (3e génération) et Fast Track

• Matériel audio tiers avec pilotes Core Audio

(Mac) ou ASIO (Windows) pris en charge, dont

matériel audio intégré sur Mac

Pro Tools

Le logiciel Pro Tools peut être utilisé avec le

matériel suivant :

• Interfaces Avid de la famille 003, Eleven Rack,

Mbox (3e génération) et Fast Track

• Matériel audio tiers avec pilotes Core Audio

(Mac) ou ASIO (Windows) pris en charge, dont

matériel audio intégré sur Mac
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Configuration requise et 
compatibilité
Les éléments suivants sont requis pour installer et

activer le logiciel Pro Tools :

• Un lecteur DVD (pour les versions coffret de

Pro Tools contenant un disque d'installation)

• Une connexion Internet (pour le téléchargement du

programme d'installation de Pro Tools et l'activation

de Pro Tools)

Les éléments suivants sont requis pour exécuter le

logiciel Pro Tools :

• Un ordinateur Windows ou Mac qualifié

• Une interface audio qualifiée (ou un

périphérique audio intégré)

• Une clé USB iLok (2e génération) pour

l'autorisation du logiciel Pro Tools

Avid ne peut assurer une compatibilité des produits

et fournir une assistance que pour les matériels et

les logiciels testés et approuvés par ses soins. Pour

connaître la configuration requise et consulter la

liste exhaustive des ordinateurs, systèmes

d'exploitation, disques durs et périphériques tiers

qualifiés, rendez-vous sur

www.avid.com/compatibility.

Pour consulter la liste des interfaces audio et
ordinateurs qualifiés avec l'ensemble des
systèmes Pro Tools, rendez-vous sur
www.avid.com/compatibility.
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À propos de la clé iLok
L'autorisation du logiciel Pro Tools est activée à

l'aide d'une clé USB iLok (2e génération) de PACE

Anti-Piracy. Une clé iLok peut stocker des

centaines d'autorisations pour l'ensemble de vos

logiciels activés par ce procédé. Lorsqu'une licence

a été ajoutée à une clé iLok pour un logiciel

spécifique, vous pouvez l'utiliser sur n'importe quel

ordinateur.

• Si vous avez acheté une version coffret de

Pro Tools ou un bundle matériel Avid incluant

une version du logiciel Pro Tools ou

Pro Tools HD, une clé USB iLok (2e génération)

ainsi qu'une carte d'activation avec un code

d'activation imprimé vous ont été fournies.

• Si vous procédez à une mise à niveau depuis une

version antérieure du logiciel Pro Tools ou

Pro Tools HD, vous devez utiliser votre propre

clé USB iLok (une clé iLok 2e génération est

requise). Vous recevrez un code d'activation sur

votre compte Avid en ligne.

Configuration MIDI requise
Les interfaces MIDI USB, FireWire et PCI

fonctionnent de manière optimale avec les

systèmes Pro Tools sur Mac ou Windows.

Configuration requise des 
disques durs
Pour une qualité d'enregistrement et de lecture audio

optimale, tous les systèmes Pro Tools requièrent un

ou plusieurs disques durs qualifiés.

Clé USB iLok (2e génération)
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Enregistrement déconseillé sur le 
disque système

L'enregistrement audio sur votre disque système est

possible, mais déconseillé. Les disques durs système

affichent parfois des performances inférieures en

enregistrement et en lecture, ce qui se traduit par un

nombre inférieur de pistes et de plug-ins

exploitables.

Présentation de l'installation
L'installation de Pro Tools inclut les étapes

suivantes :

1 « Création de votre compte Avid » à la page 11.

2 « Récupération de la licence de votre logiciel

Pro Tools | Software » à la page 11.

3 « Suppression de versions antérieures de

Pro Tools | Software » à la page 11.

4 « Installation des pilotes matériels » à la

page 11.

5 « Installation du logiciel Pro Tools | Software »

à la page 12.

6 « Démarrage et arrêt de votre système » à la

page 12.

7 « Lancement et activation de

Pro Tools | Software » à la page 13.

8 Configuration de votre système pour optimiser

les performances.

Pour garantir des performances optimales,
vous pouvez désigner votre disque système en
tant que volume de lecture ou de transfert dans
l'espace de travail de Pro Tools. Pour plus
d'informations, consultez le Guide de
référence Pro Tools.
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Création de votre compte 
Avid
Un compte Avid est nécessaire pour activer le

logiciel Pro Tools et télécharger votre logiciel si

vous avez acheté une version téléchargeable de

Pro Tools.

 Si vous ne possédez pas de compte Avid, rendez-

vous sur www.avid.com/myavid pour en créer un.

Récupération de la licence de 
votre logiciel 
Pro Tools | Software
Lorsque vous achetez Pro Tools, vous recevez un

code d'activation sur une carte d'activation ou votre

compte Avid.

Pour récupérer la licence de votre logiciel

Pro Tools :

1 Si vous ne possédez pas encore de compte iLok,

rendez-vous sur www.ilok.com pour en créer un.

2 Rendez-vous sur www.avid.com/activation et

connectez-vous à votre compte Avid (si vous ne

possédez pas encore de compteAvid, cliquez sur

Créer votre compte).

3 Saisissez votre code d'activation et votre ID

utilisateur iLok.com.

4 Suivez les instructions à l'écran pour transférer

votre licence sur votre compte iLok.com.
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Suppression de versions 
antérieures de 
Pro Tools | Software
Si une version antérieure de Pro Tools est installée

sur votre ordinateur, désinstallez-la en suivant les

instructions du Guide d'installation de cette

version.

Installation des pilotes 
matériels
Avant d'installer le logiciel Pro Tools, installez les

pilotes les plus récents pour votre matériel.

Reportez-vous à la documentation fournie avec votre

matériel audio pour de plus amples informations.

Pour les interfaces audio Avid, téléchargez et

installez les pilotes de votre matériel Avid depuis le

site www.avid.com/drivers.

Pro Tools version 10.3.6 ou supérieure peut être
installé simultanément avec Pro Tools 11.
Rendez-vous sur www.avid.com/compatibility
ou consultez le fichier Lisez-moi Pro Tools
pour plus de détails.

Pro Tools ne reconnaîtra pas votre interface
audio si ses pilotes ne sont pas installés. Si
vous effectuez une mise à niveau de Pro Tools,
assurez-vous d'avoir au préalable installé les
pilotes matériels les plus récents.
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Installation du logiciel 
Pro Tools | Software
Après avoir installé les pilotes de votre interface

audio, vous pouvez installer Pro Tools.

Installation de Pro Tools sur Mac

Pour installer Pro Tools sur Mac :

1 Effectuez l'une des opérations suivantes :

• Insérez le disque d'installation de Pro Tools dans

le lecteur DVD de votre ordinateur.

• Téléchargez le programme d'installation de

Pro Tools depuis votre compte Avid en ligne.

2 Ouvrez le disque ou l'image de disque de

Pro Tools.

3 Double-cliquez sur Install Pro Tools 11.3.pkg.

4 Suivez les instructions à l'écran afin de

poursuivre l'installation.

5 Suivez les instructions à l'écran afin de

poursuivre l'installation.

Installation de Pro Tools sous 
Windows

Pour installer Pro Tools sous Windows :

1 Assurez-vous que vous êtes connecté en tant

qu'administrateur au compte sur lequel vous

souhaitez installer Pro Tools.

2 Effectuez l'une des opérations suivantes :

• Insérez le disque d'installation de Pro Tools dans

votre lecteur DVD.

• Téléchargez le programme d'installation de

Pro Tools depuis votre compte Avid en ligne.

Avant d'installer Pro Tools, consultez le
fichier Lisez-moi Pro Tools inclus avec le
programme d'installation.
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3 Effectuez l'une des opérations suivantes :

• Si l'exécution automatique est activée, une

fenêtre apparaît. Sélectionnez Install Pro Tools

pour commencer l'installation.

• Si l'exécution automatique est désactivée,

naviguez jusqu'au fichier Setup.exe, puis double-

cliquez dessus et sélectionnez l'option Install

Pro Tools pour lancer l'installation.

4 Suivez les instructions à l'écran pour continuer

la procédure d'installation.

5 Lorsque l’assistant d'installation a terminé,

cliquez sur Terminer.

Démarrage et arrêt de votre 
système
Pour que les différents composants de votre

système Pro Tools puissent communiquer

correctement entre eux, vous devez les mettre sous

tension dans un ordre particulier.

Démarrez votre système Pro Tools dans l'ordre

suivant :

1 Assurez-vous que tous vos appareils (y compris

votre ordinateur) sont éteints.

2 Baissez le volume de tous les périphériques de

sortie du système.

Si la boîte de dialogue Contrôle de compte
utilisateur de Windows s'affiche, cliquez sur
Autoriser. Plusieurs messages s'affichent
pendant l'installation, comme les boîtes de
dialogue « Nouveau matériel détecté » et « Un
problème est survenu pendant l'installation du
matériel ». Vous pouvez les ignorer. De plus, si
un message d'avertissement indique que le
pilote n'a pas été validé lors du test permettant
d'obtenir le logo Windows, cliquez sur
Continuer.
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3 Pour les systèmes avec châssis d'extension,

mettez ce dernier sous tension.

4 Mettez tous les disques durs externes sous

tension. Patientez environ 10 secondes jusqu'à

ce qu'ils aient atteint leur vitesse nominale.

5 Mettez vos surfaces de contrôle sous tension, le

cas échéant.

6 Mettez les interfaces et périphériques MIDI, ou

les périphériques de synchronisation sous

tension.

7 Mettez sous tension le matériel fonctionnant sur

une source d'alimentation externe (HD I/O ou

003 par exemple). Patientez au minimum quinze

secondes (durée d'initialisation de l'interface

audio). Les LED d'état cessent de clignoter.

8 Mettez l'ordinateur sous tension.

9 Lancez Pro Tools (reportez-vous à la section

« Lancement et activation de

Pro Tools | Software » à la page 13).

Arrêtez votre système Pro Tools dans l'ordre

suivant :

1 Quittez Pro Tools (Mac : Pro Tools > Quit, ou

Windows : File > Exit).

2 Baissez le volume de tous les périphériques de

sortie du système.

3 Mettez votre ordinateur hors tension.

4 Mettez hors tension le matériel fonctionnant sur

une source d'alimentation externe, pour les

systèmes concernés.

5 Éteignez toutes les interfaces audio Pro Tools.

6 Pour les systèmes avec châssis d'extension,

mettez ce dernier sous tension.

7 Mettez hors tension les interfaces et

périphériques MIDI ou les périphériques de

synchronisation.
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8 Mettez hors tension les éventuelles surfaces de

contrôle ou de travail.

9 Mettez hors tension les disques durs externes.

Lancement et activation de 
Pro Tools | Software
Pour lancer et activer le logiciel Pro Tools :

1 Vérifiez que votre interface audio est bien

connectée à votre ordinateur et sous tension.

2 Assurez-vous que votre clé iLok (2e génération)

est connectée à un port USB de votre ordinateur.

3 Effectuez l'une des opérations suivantes :

• Sur Mac, double-cliquez sur l'icône de

l'application sous Macintosh

HD/Applications/Pro Tools.

• Sous Windows, double-cliquez sur le raccourci

Pro Tools du bureau ou sur l'application située

dans le dossier Programmes\Avid\Pro Tools.

4 À l'ouverture de l'écran d'activation de

Pro Tools, cliquez sur Activate.

5 Connectez-vous à votre compte iLok.com. Si

vous n'en possédez pas encore, cliquez sur

Create New Account.

6 Lorsque la liste des licences disponibles

apparaît, sélectionnez la licence pour

Pro Tools 11 et cliquez sur Next.

7 Sélectionnez votre clé iLok en tant

qu'emplacement de destination de la licence et

cliquez sur Next.

8 À l'issue de la procédure d'activation, cliquez sur

Continue pour lancer Pro Tools.

Ne retirez pas la clé iLok lors de l'ouverture ou
de l'exécution de Pro Tools.
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Configuration de votre 
système Pro Tools
Une fois le logiciel Pro Tools installé, activé et

ouvert, vous pouvez configurer votre système en

fonction des caractéristiques de votre studio. Pour

obtenir des informations détaillées sur la

configuration de votre logiciel Pro Tools, reportez-

vous au Guide de référence Pro Tools (disponible à

partir du menu d'aide de Pro Tools).

Optimisation d'un système 
Mac pour 
Pro Tools | Software
Pour garantir des performances optimales avec

Pro Tools, commencez par configurer votre

ordinateur.

Avant de configurer votre ordinateur, assurez-vous

que vous êtes connecté en tant qu'administrateur au

compte sur lequel vous souhaitez installer

Pro Tools. Pour obtenir des détails sur les

privilèges d'administrateur sous Mac OS X,

reportez-vous à votre documentation Apple OS X.

Pour obtenir une liste complète des
optimisations recommandées pour votre
système d'exploitation, rendez-vous sur
www.avid.com/optimize.

N'utilisez pas la fonction de mise à jour
logicielle automatique de Mac OS X, car votre
système pourrait être mis à niveau vers une
version de Mac OS qui n'a pas été qualifiée
pour Pro Tools. Pour connaître les versions
qualifiées de Mac OS, rendez-vous sur
www.avid.com/compatibility.
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Désactivation de l'économiseur 
d'énergie

Pour désactiver l'économiseur d'énergie :

1 Dans le menu Pomme, sélectionnez Préférences

Système.

2 Cliquez sur Économiseur d'énergie.

3 Définissez le Mode de veille sur Jamais.

4 Définissez le paramètre de Veille d'affichage sur

Jamais.

5 Désélectionnez Suspendre dès que possible

l'activité du ou des disques durs.

Désactivation ou réassignation des 
raccourcis clavier Mac utilisés par 
Pro Tools

Pour exploiter tous les raccourcis clavier de

Pro Tools, vous devez désactiver ou réassigner les

éventuels raccourcis clavier Mac OS X en conflit

dans les préférences système Apple.

Pour désactiver ou réaffecter les raccourcis clavier

Mac utilisés par Pro Tools :

1 Dans le menu Pomme, sélectionnez Préférences

Système.

2 Cliquez sur Clavier.

3 Cliquez sur l'onglet Raccourcis clavier.

4 Vous pouvez désactiver ou réassigner les

raccourcis clavier Mac OS en conflit avec ceux de

Pro Tools. La liste suivante répertorie plusieurs

raccourcis clavier Mac courants qui peuvent

également être utilisés par Pro Tools, en fonction du

modèle et de la configuration de votre Mac :

• Sous « Launchpad et Dock »

• « Activer/désactiver le masquage du Dock »

Pour obtenir une liste complète des raccourcis
clavier de Pro Tools, reportez-vous au Guide
des raccourcis Pro Tools (Help > Pro Tools
Shortcuts).
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• Sous « Mission Control »

• « Mission Control »

• « Fenêtres d'applications »

• « Afficher le bureau »

• « Afficher le Dashboard »

• « Mission Control > Déplacer d'un espace

vers la gauche »

• « Mission Control > Déplacer d'un espace

vers la droite »

• « Mission Control > Passer au Bureau n »

• Sous « Clavier et saisie de texte »

• « Activer/désactiver l'accès au clavier »

• « Déplacer la cible sur le volet de la fenêtre »

• « Déplacer la cible sur le Dock »

• « Déplacer la cible sur la fenêtre active ou

suivante »

• Sous « Services »

• « Envoyer le fichier vers un appareil

Bluetooth »

• « Rechercher avec Google »

• « Spotlight »

• Sous « Spotlight »

• « Afficher le champ de recherche Spotlight »

• « Afficher la fenêtre Spotlight »

• Sous « Accessibilité »

• « Zoom »

• « Contraste »

• Sous « Raccourcis d'applications »

• « Afficher le menu Aide »
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Activation de la journalisation des 
lecteurs audio

Les performances des lecteurs audio peuvent être

améliorées en activant la journalisation.

Pour activer la journalisation :

1 Dans le dossier Applications/Utilitaires,

démarrez l'application Utilitaire de disque.

2 Sélectionnez le volume dans la colonne de

gauche de la fenêtre Utilitaire de disque.

3 Sélectionnez Activer la journalisation dans la

barre d'outils.

Optimisation d'un système 
Windows pour 
Pro Tools | Software
Pour des performances optimales avec Pro Tools,

configurez votre ordinateur avant d'utiliser le

matériel et le logiciel Pro Tools.

Avant de configurer votre ordinateur, assurez-vous

que vous êtes connecté en tant qu'administrateur au

compte sur lequel vous souhaitez installer

Pro Tools. Pour tout renseignement

complémentaire sur les privilèges d'administrateur,

reportez-vous à votre documentation Windows.

Optimisations nécessaires

Pour garantir des performances optimales,

configurez les paramètres suivants avant d'utiliser

le logiciel Pro Tools.

Pour obtenir une liste complète des optimisations
recommandées pour votre système d'exploitation,
rendez-vous sur www.avid.com/optimize.

Redémarrez votre ordinateur après avoir
modifié les paramètres système de Windows.
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Désactivation du contrôle de compte 
d'utilisateur
Pour désactiver le contrôle de compte

d'utilisateur :

1 Sélectionnez Démarrer > Panneau de

configuration.

2 Cliquez sur Comptes et protection des

utilisateurs.

3 Cliquez sur Comptes d'utilisateur.

4 Cliquez sur Modifier les paramètres de contrôle

de compte d'utilisateur.

5 Déplacez le curseur sur Ne jamais m'avertir.

6 Cliquez sur OK.

Configuration de la mise en veille et de 
la gestion de l'alimentation

Si vous utilisez Pro Tools, le mode de mise en veille

du système Windows doit être défini sur Toujours

actif. Cela permet d'éviter qu'une longue session

d'enregistrement ou de lecture soit interrompue

inopinément à cause de l'arrêt de ressources

système.

Pour configurer la gestion de l'alimentation

Windows :

1 Sélectionnez Démarrer > Panneau de

configuration.

2 Cliquez sur Système et sécurité.

3 Cliquez sur Options d'alimentation.

4 Cliquez sur la flèche pour Afficher les modes

supplémentaires.

5 Sélectionnez Performances élevées.

6 Cliquez sur Modifier les paramètres du mode.

7 Cliquez sur Modifier les paramètres

d'alimentation avancés.
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8 Dans la boîte de dialogue Options

d'alimentation, développez l'option Disque dur >

Arrêter le disque dur après.

9 Cliquez sur l'option Paramètre.

10 Sélectionnez une valeur dans le champ

Paramètre (Minutes) et appuyez sur la touche

Retour arrière du clavier ou sélectionnez Jamais

dans la liste déroulante.

11 Cliquez sur OK. Le paramètre du disque dur est

défini sur Jamais et la boîte de dialogue Options

d'alimentation se ferme.

12 Dans la fenêtre Modifier les paramètres du mode

de gestion de l'alimentation, cliquez sur

Enregistrer les modifications puis fermez la

fenêtre.

Optimisations recommandées
D'autres pilotes logiciels et matériels installés sur

votre ordinateur peuvent également interférer avec

Pro Tools. Pour obtenir des performances

optimales, nous vous suggérons d'effectuer les

opérations suivantes :

• Évitez d'exécuter simultanément Pro Tools et des

programmes dont vous n'avez pas absolument

besoin.

Lors de son ouverture, Pro Tools modifie
automatiquement les paramètres d'alimentation
en les définissant sur Performances élevées. Si
vous les aviez modifiés, les paramètres
d'alimentation d'origine de Windows sont
rétablis lorsque vous quittez le logiciel
Pro Tools. Par conséquent, lorsque vous
souhaitez optimiser les paramètres de gestion
de l'alimentation pour Pro Tools, vous devez
configurer uniquement le mode Performances
élevées.
16



• Désactivez les logiciels qui fonctionnent en

tâche de fond, tels que Windows Messenger, les

calendriers et les programmes de maintenance de

disque.

• Lorsque vous exécutez Pro Tools, éteignez tous

les périphériques USB non indispensables.

Optimisations facultatives
Les optimisations du système suivantes peuvent

améliorer les performances de Pro Tools sur certains

systèmes. Il est recommandé de ne recourir à ces

optimisations qu'en cas de nécessité, car elles

peuvent désactiver ou compromettre certaines

fonctionnalités d'autres programmes installés sur

votre système.

Réglage de la planification du 
processeur

Pour régler les performances de planification du

processeur :

1 Cliquez avec le bouton droit de la souris sur

Ordinateur, puis sélectionnez Propriétés.

2 Cliquez sur Paramètres système avancés.

3 Dans la zone Performances, cliquez sur le

bouton Paramètres.

4 Dans la fenêtre Options de performances,

cliquez sur l'onglet Avancé.

5 Dans la section Performance des applications,

sélectionnez l'option Services d'arrière-plan.

6 Cliquez sur OK pour fermer la fenêtre Options

de performances.

7 Cliquez sur OK pour fermer la fenêtre Propriétés

système.
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Désactivation des éléments de 
démarrage du système

Plus le nombre de processus actifs sur votre

ordinateur est faible, plus les ressources

disponibles pour Pro Tools sont importantes.

Certaines applications de démarrage consomment

inutilement les ressources du processeur et peuvent

être désactivées.

Ne désactivez les éléments de démarrage suivants

qu'en toute connaissance de cause :

• le numéro de série d'un support mobile

(nécessaire aux applications utilisant une clé de

protection contre la copie)

• le service Plug and Play

• le journal d'événements

• les services cryptographiques.

Pour désactiver les éléments de démarrage du

système :

1 Depuis le menu Démarrer, saisissez

« msconfig » dans la zone de recherche et

appuyez sur Entrée pour ouvrir l'utilitaire de

configuration du système.

2 Sous l'onglet Général, sélectionnez Démarrage

sélectif.

3 Désactivez l'option Charger les éléments de

démarrage, puis cliquez sur OK.

4 Cliquez sur Redémarrer pour redémarrer

l'ordinateur.
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5 Après le redémarrage, un message relatif à la

configuration système s'affiche à l'écran.

Vérifiez que les performances de Pro Tools ont

été améliorées avant de désactiver la case « Ne

plus afficher ce message ». Si les performances

n'ont pas été améliorées, exécutez l'utilitaire

msconfig et sélectionnez le mode Démarrage

normal (charger tous les pilotes de périphérique

et tous les services) au lieu du mode de

démarrage sélectif, ou désactivez un par un les

éléments lancés au démarrage et les processus non

indispensables.

Sauvegarde de votre système
Une fois la configuration du système et

l'installation de Pro Tools terminées, enregistrez

une image de votre disque système à l'aide d'un

utilitaire de sauvegarde. Cette opération vous

permet, en cas de problèmes, de restaurer

rapidement la configuration et les paramètres de

votre système.
Installation du logiciel Pro Tools | Software
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Installieren der Pro Tools | Software
Willkommen bei Pro Tools® | Software von Avid. In

diesem Handbuch erfahren Sie, wie Sie Pro Tools-

Software auf Mac- und Windows-Systemen

installieren und autorisieren. Nähere

Informationen zur Konfiguration Ihres Pro Tools-

Systems sowie über dessen volle Funktionalität

erhalten Sie im Pro Tools-Referenzhandbuch
(Zugriff über das Hilfemenü in Pro Tools).

Es gibt zwei Arten von Pro Tools-Software:

Pro Tools HD

Pro Tools HD-Software kann mit der folgenden

Hardware verwendet werden:

• Pro Tools | HDX-Hardware für erweiterte

Anschlussmöglichkeiten, Niedriglatenz-

Monitoring sowie dedizierte DSP-Leistung für

die Plug-In-Verarbeitung und große Mixer-

Konfigurationen

• Pro Tools | HD Native-Hardware für erweiterte

Anschlussmöglichkeiten und Niedriglatenz-

Monitoring

• Avid 003™-Produktfamilie, Eleven® Rack,

Mbox® (3. Generation) und Fast Track-Hardware

• Audio-Hardware anderer Hersteller mit

unterstützten Treibern von Core Audio (Mac)

oder ASIO (Windows), einschließlich

integrierter Audio-Hardware auf Mac-

Computern
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Pro Tools

Pro Tools-Software kann mit der folgenden

Hardware verwendet werden:

• Avid 003-Produktfamilie, Eleven Rack, Mbox

(3. Generation) und Fast Track-Hardware

• Audio-Hardware anderer Hersteller mit

unterstützten Treibern von Core Audio (Mac)

oder ASIO (Windows), einschließlich

integrierter Audio-Hardware auf Mac-

Computern

Systemanforderungen und 
Kompatibilität
Für das Installieren und Autorisieren der

Pro Tools-Software benötigen Sie Folgendes:

• Ein DVD-Laufwerk (wenn Sie eine Box-Version

von Pro Tools mit Installations-DVD erworben

haben)

• Eine Internetverbindung (für den Download des

Pro Tools-Installationsprogramms und die

Pro Tools-Autorisierung)

Für das Ausführen der Pro Tools-Software

benötigen Sie Folgendes:

• Einen qualifizierten Windows- oder Mac-

Computer

• Ein qualifiziertes Audio-Interface (oder

integrierte Audiofunktion)

• Einen iLok USB Key (2. Generation) für die

Autorisierung der Pro Tools-Software

Eine Liste der qualifizierten Audio-Interfaces
und Computer für alle Pro Tools-Systeme
finden Sie unter: www.avid.com/compatibility.
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Avid kann die Kompatibilität und technische

Unterstützung nur für Hardware- und

Softwarekomponenten zusichern, die entsprechend

geprüft und genehmigt wurden. Die vollständigen

Systemanforderungen und eine Liste der

qualifizierten Computer, Betriebssysteme,

Festplatten und Geräte von Drittanbietern finden

Sie unter www.avid.com/compatibility.

Über iLok
Pro Tools-Software wird mit Hilfe des iLok USB Key

(2.Generation) von PACE Anti-Piracy autorisiert. Ein

iLok kann über 100 Autorisierungen für alle Ihre

iLok-geschützten Anwendungen speichern.

Nachdem auf dem iLok eine Softwarelizenz

gespeichert wurde, können Sie mit dem iLok

diese Software auf beliebigen Computern

autorisieren.

• In der Box-Version von Pro Tools oder dem Avid-

Hardware-Bundle mit einer Version der Pro Tools-

oder Pro Tools HD-Software ist ein iLok USB

Key (2. Generation) und eine Aktivierungskarte

mit einem Aktivierungscode enthalten.

• Wenn Sie ein Upgrade von einer früheren

Version von Pro Tools- oder Pro Tools HD-

Software durchführen, benötigen Sie Ihren eigenen

iLok USB Key (ein iLok der 2. Generation ist

erforderlich). Sie erhalten einen

Aktivierungscode über Ihr Online-Avid-Konto.

MIDI-Anforderungen
USB-, FireWire- und PCI MIDI-Interfaces

funktionieren mit Pro Tools-Systemen auf Mac

oder unter Windows.

iLok USB Key (2. Generation)
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Anforderungen an die 
Festplatten
Für eine optimale Audioaufnahme und -

wiedergabe benötigen alle Pro Tools-Systeme

mindestens eine von Avid qualifizierte Festplatte.

Nicht auf das Systemlaufwerk 
aufnehmen

Das Aufnehmen auf das Systemlaufwerk ist

möglich, aber nicht empfehlenswert. Bei

Aufnahme und Wiedergabe auf Systemlaufwerken

können weit weniger Spuren und Plug-Ins verwendet

werden.

Überblick zur Installation
Bei der Installation von Pro Tools sind die

folgenden Schritte auszuführen:

1 Abschnitt Erstellen Ihres Avid-Kontos auf

Seite 21.

2 Abschnitt Abrufen Ihrer Pro Tools | Software

auf Seite 21.

3 Abschnitt Entfernen früherer Versionen von

Pro Tools | Software auf Seite 21.

4 Abschnitt Installieren von Hardware-Treibern

auf Seite 21.

5 Abschnitt Installieren der Pro Tools | Software

auf Seite 22.

6 Abschnitt Starten bzw. Herunterfahren des

Systems auf Seite 23.

7 Abschnitt Starten und Autorisieren von

Pro Tools | Software auf Seite 23.

Für optimale Leistung kann es von Vorteil
sein, Ihr Systemlaufwerk als Laufwerk im
Pro Tools-Workspace für die Wiedergabe oder
nur für die Übertragung einzurichten. Weitere
Informationen hierzu finden Sie im Pro Tools-
Referenzhandbuch.
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8 Konfigurieren Ihres Systems zur

Leistungsoptimierung.

Erstellen Ihres Avid-Kontos
Für die Aktivierung der Pro Tools-Software und

dem Software-Download, falls Sie eine Download-

Version von Pro Tools erworben haben, ist ein

Avid-Konto erforderlich.

 Wenn Sie kein Avid-Konto haben, können Sie

unter www.avid.com/myavid Ihr Konto erstellen.

Abrufen Ihrer 
Pro Tools | Software
Wenn Sie Pro Tools erwerben, erhalten Sie einen

Aktivierungscode, entweder auf einer

Aktivierungskarte oder über Ihr Avid-Konto.

So rufen Sie Ihre Pro Tools-Softwarelizenz ab:

1 Wenn Sie noch kein iLok.com-Konto haben,

erstellen Sie sich eines auf www.iLok.com.

2 Rufen Sie die Website www.avid.com/activation
auf und melden Sie sich bei Ihrem Avid-Konto

an. (Wenn Sie noch kein Konto haben, klicken

Sie auf „Erstellen Sie Ihr Konto“.)

3 Geben Sie Ihren Aktivierungscode und Ihre

iLok.com-Benutzer-ID ein.

4 Befolgen Sie die Anweisungen auf dem

Bildschirm, um die Lizenz in Ihrem iLok.com-

Konto abzulegen.
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Entfernen früherer Versionen 
von Pro Tools | Software
Wenn noch eine frühere Version von Pro Tools

installiert ist, entfernen Sie diese entsprechend den

Anweisungen im Installationshandbuch für diese

Version.

Installieren von Hardware-
Treibern
Installieren Sie vor der Installation der Pro Tools-

Software die neuesten Treiber für diese Hardware.

Weitere Hinweise hierzu finden Sie in der

Dokumentation zu Ihrer Audio-Hardware. Laden

Sie für Avid-Audio-Interfaces die Treiber für Ihre

Avid-Hardware von www.avid.com/drivers
herunter und installieren Sie sie.

Es ist möglich, gleichzeitig Pro Tools 10.3.6
oder höher und Pro Tools 11 installiert zu
haben. Details dazu finden Sie unter
www.avid.com/compatibility oder in der
Pro Tools-Readme-Datei.

Pro Tools erkennt Ihre Audio-Interfaces nicht,
wenn Sie die Treiber nicht installieren. Wenn
Sie ein Upgrade von Pro Tools vornehmen,
achten Sie darauf, die neuesten Treiber für
Ihre Hardware zu installieren.
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Installieren der 
Pro Tools | Software
Nachdem Sie die Treiber für Ihr Audio-Interface

installiert haben, können Sie Pro Tools installieren.

Installieren von Pro Tools auf 
Mac

So installieren Sie Pro Tools auf dem Mac:

1 Führen Sie einen der folgenden Schritte aus:

• Legen Sie die Installations-DVD für Pro Tools in

das DVD-Laufwerk Ihres Computers ein.

• Laden Sie das Pro Tools-Installationsprogramm

von Ihrem Online-Avid-Konto herunter.

2 Öffnen Sie die Pro Tools-DVD oder das

Pro Tools-Image.

3 Doppelklicken Sie auf Install Pro Tools

11.3.pkg.

4 Folgen Sie den Bildschirmanweisungen um die

Installation fortzuführen.

5 Wenn die Installation abgeschlossen wurde,

klicken Sie auf Schlie en.

Installieren von Pro Tools unter 
Windows

So installieren Sie Pro Tools unter Windows:

1 Sie müssen als Administrator für das Konto

angemeldet sein, für das Sie Pro Tools

installieren möchten.

Lesen Sie vor dem Installieren von Pro Tools
die Pro Tools-Readme-Datei, die im
Installationsprogramm enthalten ist.
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2 Sie haben folgende Möglichkeiten:

• Legen Sie den Pro Tools-Installationsdatenträger

in das DVD-Laufwerk ein.

• Laden Sie das Pro Tools-Installationsprogramm

von Ihrem Online-Avid-Konto herunter.

3 Sie haben folgende Möglichkeiten:

• Wenn Windows Autorun aktiviert ist, wird ein

Mini-Browser geöffnet. Wählen Sie Install

Pro Tools, um mit der Installation zu beginnen.

• Wenn Sie von der DVD installieren und

Windows Autorun deaktiviert ist, doppelklicken

Sie auf die Datei Setup.exe und wählen Sie dann

Install Pro Tools, um mit der Installation zu

beginnen.

4 Folgen Sie den Installationsanweisungen auf dem

Bildschirm, um mit der Installation fortzufahren.

5 Wenn der Installations-Assistent fertig ist,

klicken Sie auf Beenden.

Unter Windows klicken Sie im Dialogfeld der
Benutzerkontensteuerung auf „Erlauben“.
Während der Installation werden mehrere
Meldungen angezeigt, die ignoriert werden
können, darunter mehrfache „Neue Hardware
gefunden“-Dialogfelder und „Während der
Hardwareinstallation ist ein Problem
aufgetreten“-Meldungen. Sollte an dieser
Stelle eine Warnmeldung bezüglich des nicht
bestandenen Windows-Logo-Tests eines
Treibers angezeigt werden, ignorieren Sie
diese und klicken auf „Weiter“.
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Starten bzw. Herunterfahren 
des Systems
Damit die einzelnen Komponenten Ihres

Pro Tools-Systems ordnungsgemäß miteinander

kommunizieren können, müssen sie in einer

bestimmten Reihenfolge gestartet werden.

Starten Sie das Pro Tools-System in dieser

Reihenfolge:

1 Vergewissern Sie sich, dass sämtliche Geräte

(einschließlich des Computers) ausgeschaltet

sind.

2 Reduzieren Sie die Lautstärke aller

Ausgabegeräte des Systems.

3 Schalten Sie bei Systemen mit

Erweiterungschassis zuerst dieses Chassis ein.

4 Schalten Sie alle externen Festplatten ein.

Warten Sie 10 Sekunden, bis diese ihre

Betriebsgeschwindigkeit erreicht haben.

5 Schalten Sie alle Bedienoberflächen ein.

6 Schalten Sie MIDI-Interfaces, MIDI-Geräte

und/oder Synchronisationseinheiten ein.

7 Bei Systemen, die eine externe

Stromversorgung benötigen, schalten Sie die

Hardware ein (wie etwa HD I/O oder 003).

Warten Sie mindestens 15 Sekunden, bis das

Audio-Interface initialisiert ist. Die Status-

LEDs hören dann auf zu blinken.

8 Schalten Sie Ihren Computer ein.

9 Starten Sie Pro Tools (siehe Abschnitt Starten

und Autorisieren von Pro Tools | Software auf

Seite 23).
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Fahren Sie das Pro Tools-System in der folgenden

Reihenfolge herunter:

1 Beenden Sie Pro Tools (auf dem Mac: Pro Tools

> Quit oder unter Windows: File > Exit).

2 Schalten Sie die Ausgabegeräte des Systems aus

oder reduzieren Sie die Lautstärke auf das

Minimum.

3 Schalten Sie Ihren Computer aus.

4 Bei Systemen mit Hardware, die eine externe

Stromversorgung benötigt, schalten Sie die

Hardware aus.

5 Schalten Sie die Pro Tools-Audio-Interfaces ein.

6 Schalten Sie bei Systemen mit

Erweiterungschassis zuerst dieses Chassis aus.

7 Schalten Sie MIDI-Interfaces, MIDI-Geräte und

Synchronisationsgeräte aus.

8 Schalten Sie alle Bedienoberflächen aus.

9 Schalten Sie die externen Festplatten aus.

Starten und Autorisieren von 
Pro Tools | Software
So starten und autorisieren Sie die Pro Tools-

Software:

1 Vergewissern Sie sich, dass das Audio-Interface

mit dem Computer verbunden und eingeschaltet

ist.

2 Stellen Sie sicher, dass Ihr iLok (2. Generation)

mit einem USB-Anschluss an Ihrem Computer

verbunden ist.

Der iLok darf während des Starts und der
Verwendung von Pro Tools nicht entfernt
werden.
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3 Sie haben folgende Möglichkeiten:

• Auf dem Mac doppelklicken Sie auf das

Programmsymbol in

Macintosh HD/Programme/Avid/Pro Tools.

• Unter Windows doppelklicken Sie auf die

Pro Tools-Verknüpfung auf dem Desktop (oder

doppelklicken Sie auf die Anwendungsdatei in

Programme\Avid\Pro Tools).

4 Wenn der Pro Tools-Aktivierungsbildschirm

angezeigt wird, klicken Sie auf Activate.

5 Melden Sie sich bei Ihrem iLok.com-Konto an.

(Wenn Sie kein iLok-Konto haben, klicken Sie

auf Neues Konto erstellen.)

6 Wenn die Liste der verfügbaren Lizenzen

angezeigt wird, wählen Sie die Lizenz für

Pro Tools 11 aus und klicken Sie auf Next.

7 Wählen Sie Ihren iLok als Speicherort für die

Lizenz aus und klicken Sie auf Next.

8 Nachdem die Aktivierung abgeschlossen ist,

klicken Sie auf Continue, um Pro Tools zu

starten.

Konfigurieren des Pro Tools-
Systems
Nachdem Sie die Pro Tools-Software installiert,

autorisiert und gestartet haben, können Sie Ihr

Pro Tools-System konfigurieren, um es an die

besonderen Anforderungen Ihres Studios anzupassen.

Detaillierte Hinweise zur Konfiguration Ihrer

Pro Tools-Software finden Sie im Pro Tools-
Referenzhandbuch (Zugriff über das Hilfemenü

von Pro Tools).
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Optimieren eines Mac-
Systems für 
Pro Tools | Software
Damit Pro Tools optimal funktioniert, müssen Sie
den Computer vor der Verwendung der Pro Tools-
Software konfigurieren.

Vor dem Konfigurieren Ihres Computers müssen
Sie als Administrator für das Konto angemeldet
sein, für das Sie Pro Tools installieren möchten.
Weitere Informationen zur Anmeldung als
Administrator auf Mac OS X finden Sie in der
Dokumentation zu Apple OS X.

Deaktivieren der Energiesparfunktion
So deaktivieren Sie die Funktion „Energie sparen“:

1 Wählen Sie aus dem Apple-Menü
Systemeinstellungen.

2 Klicken Sie auf Energie sparen.

3 Setzen Sie die Einstellung für den Ruhezustand
des Computers auf Nie.

4 Setzen Sie die Einstellung für den Ruhezustand
des Monitors auf Nie.

5 Heben Sie die Auswahl der Option Wenn
möglich Ruhezustand der Festplatte(n)
aktivieren auf.

Eine vollständige Liste empfohlener
Optimierungen für Ihr Betriebssystem finden
Sie unter www.avid.com/optimize.

Verwenden Sie keinesfalls die Funktion zur
automatischen Software-Aktualisierung von
Mac OS X, da sonst möglicherweise eine
Version von Mac OS installiert wird, die noch
nicht für die Verwendung mit Pro Tools
qualifiziert wurde. Details zu qualifizierten
Versionen von Mac OS finden Sie unter
www.avid.com/compatibility.
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Deaktivieren oder Neuzuordnen der 
Mac-Tastenkombinationen für Pro Tools

Um alle Pro Tools-Tastenkombinationen
verwenden zu können, müssen Sie zuerst dazu im
Widerspruch stehende Mac OS X-
Tastenkombinationen in den Apple-
Systemeinstellungen deaktivieren oder neu
zuordnen.

So deaktivieren Sie Mac-Tastenkombinationen für

Pro Tools oder ordnen sie neu zu:

1 Wählen Sie aus dem Apple-Menü die Option

Systemeinstellungen.

2 Klicken Sie auf Tastatur & Maus.

3 Klicken Sie auf die Registerkarte Tastatur-

Kurzbefehle.

4 Sie können die Mac OS-Tastenkombinationen,

die mit den Pro Tools-Tastenkombinationen in

Konflikt stehen, deaktivieren oder neu

programmieren. Die folgende Liste enthält

einige häufige Mac-Tastenkombinationen, die je

nach Mac-Modell möglicherweise auch von

Pro Tools benutzt werden:

• Unter „Launchpad & Dock“

• Dock ein- oder ausblenden

• Unter „Mission Control“

• Mission Control

• Programmfenster

• Schreibtisch einblenden

• Dashboard einblenden

• Mission Control > Einen Space nach links

bewegen

• Mission Control > Einen Space nach rechts

bewegen

Eine vollständige Liste der Pro Tools-
Tastenkombinationen finden Sie in der
Dokumentation zu den Pro Tools-
Tastenkombinationen (Help > Pro Tools
Shortcuts).
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• Mission Control > Zu Schreibtisch n
wechseln

• Unter „Tastatur & Texteingabe“

• Tastatursteuerung ein- oder ausschalten

• Fokus zum aktiven oder nächsten Fenster

bewegen

• Fokus zum Dock bewegen

• Fokus zum aktiven oder nächsten Fenster

bewegen

• Unter „Dienste“

• Datei an Bluetooth-Gerät senden

• Mit Google suchen

• Spotlight

• Unter „Spotlight“

• Spotlight-Suchfeld einblenden

• Spotlight-Fenster einblenden

• Unter „Zugriff“

• Zoom

• Kontrast

• Unter dem Menü für Programm-Kurzbefehle

• Hilfemenü einblenden

Aktivieren von Journaling für 
Audiolaufwerke

Um die Leistung der Audiolaufwerke zu

verbessern, können Sie Journaling aktivieren.

So aktivieren Sie Journaling:

1 Starten Sie das Festplattendienstprogramm (im

Ordner „Programme/Dienstprogramme“).

2 Wählen Sie in der linken Spalte des Festplatten-

Dienstprogramm-Fensters das Volume aus.

3 Wählen Sie in der Symbolleiste Journaling

aktivieren.
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Optimieren eines Windows-
Systems für 
Pro Tools | Software
Damit Pro Tools optimal funktioniert, müssen Sie

den Computer vor der Verwendung der Pro Tools-

Hardware und -Software konfigurieren.

Vor dem Konfigurieren Ihres Computers müssen

Sie als Administrator für das Konto angemeldet

sein, für das Sie Pro Tools installieren möchten.

Weitere Informationen hierzu finden Sie in der

Windows-Dokumentation.

Erforderliche Optimierungsmaßnahmen

Für eine optimale Leistung von Pro Tools sollten

Sie vor dem Verwenden der Pro Tools-Hardware

und -Software die im Folgenden beschriebenen

Einstellungen vornehmen.

Benutzerkontensteuerung deaktivieren
So deaktivieren Sie die Benutzerkontensteuerung:

1 Wählen Sie Start > Systemsteuerung.

2 Klicken Sie auf Benutzerkonten und

Jugendschutz.

3 Klicken Sie auf Benutzerkonten.

4 Klicken Sie auf Einstellungen der

Benutzerkontensteuerung ändern.

5 Setzen Sie den Schieberegler auf Nie

benachrichtigen.

6 Klicken Sie auf OK.

Eine vollständige Liste von empfohlenen
Optimierungen für Ihr Betriebssystem finden
Sie unter www.avid.com/optimize.

Nachdem Sie die erforderlichen Windows-
Systemeinstellungen geändert haben, starten
Sie den Computer neu.
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Konfigurieren von System-Standby und 
Energieverwaltung

Bei der Arbeit mit Pro Tools muss das

Energieschema für Windows-System-Standby

immer auf Dauerbetrieb gesetzt sein. Dadurch wird

vermieden, dass lange Aufnahme- oder

Wiedergabedurchläufe aufgrund eines plötzlichen

Ausfalls der Systemressourcen unterbrochen

werden.

So konfigurieren Sie die Windows-

Energieverwaltung:

1 Wählen Sie Start > Systemsteuerung.

2 Klicken Sie auf System und Sicherheit.

3 Klicken Sie auf Energieoptionen.

4 Klicken Sie auf den Pfeil für die Option Weitere

Energiesparpläne einblenden.

5 Wählen Sie Hohe Leistung.

6 Klicken Sie auf Energiesparplaneinstellungen

ändern.

7 Klicken Sie auf Erweiterte Energieeinstellungen

ändern.

8 Im Dialogfeld der Energieoptionen suchen Sie

Festplatte > Festplatte ausschalten nach.

9 Klicken Sie auf die Option Einstellungen.

10 Wählen Sie im Feld für die Einstellung der

Minuten den gewünschten Wert und drücken Sie

die Rücktaste auf der Computertastatur oder

setzen Sie den Wert auf Nie.

11 Klicken Sie auf OK. Die Festplatteneinstellung

ändert sich auf Nie und das Dialogfeld für die

Energieoptionen wird geschlossen.

12 Klicken Sie im Fenster

„Energiesparplaneinstellungen bearbeiten“ auf

Änderungen speichern und schließen Sie das

Fenster.
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Empfohlene 
Optimierungsmaßnahmen
Andere auf dem Computer installierte Software-

und Hardwaretreiber können sich auf die Leistung

von Pro Tools auswirken. Beachten Sie die

folgenden Empfehlungen, um eine optimale

Leistung mit Pro Tools zu erzielen:

• Nicht erforderliche andere Programme sollten

nicht gleichzeitig mit Pro Tools ausgeführt

werden.

• Deaktivieren Sie im Hintergrund ausgeführte

Dienstprogramme (wie Windows Messenger,

Kalender und Datenträger-

Wartungsprogramme).

• Schalten Sie während der Arbeit mit Pro Tools alle

nicht unbedingt erforderlichen USB-Geräte aus.

Optionale 
Optimierungsmaßnahmen
Die folgenden Maßnahmen zur Systemoptimierung

steigern die Leistung von Pro Tools auf manchen

Systemen. Sie sollten diese

Optimierungseinstellungen nur vornehmen, wenn

dies unbedingt nötig ist, da sie sich auf die Funktion

anderer Programme Ihres Systems auswirken

können.

Pro Tools aktiviert beim Start automatisch die
Energiespareinstellung „Hohe Leistung“.
Windows kehrt in die vorher ausgewählte
Energiespareinstellung zurück, wenn
Pro Tools beendet wird. Wenn Sie also die
Energiespareinstellung für Pro Tools ändern
möchten, brauchen Sie nur die
Energiespareinstellung „Hohe Leistung“
einzustellen.
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Einstellen der Prozessorzeitplanung

So stellen Sie die Prozessorzeitplanung ein:

1 Klicken Sie mit der rechten Maustaste auf das

Symbol Arbeitsplatz und wählen Sie

Eigenschaften.

2 Klicken Sie auf Erweiterte Systemeinstellungen.

3 Klicken Sie unter „Leistung“ auf die

Schaltfläche Einstellungen.

4 Klicken Sie im Dialogfeld „Leistungsoptionen“

auf die Registerkarte Erweitert.

5 Wählen Sie im Abschnitt

„Prozessorzeitplanung“ die Option

Hintergrunddienste.

6 Klicken Sie auf OK, um das Dialogfeld

„Leistungsoptionen“ zu schließen.

7 Klicken Sie auf OK, um das Dialogfeld

„Systemeigenschaften“ zu schließen.

Deaktivieren von Elementen für den 
Systemstart

Je weniger Elemente von Ihrem Computer benutzt

werden, desto mehr Ressourcen sind für Pro Tools

verfügbar. Manche Systemstartelemente

verbrauchen unnötigerweise Rechnerressourcen und

sollten daher deaktiviert werden.

Gehen Sie beim Deaktivieren der folgenden

Systemstartelemente sorgfältig vor:

• Seriennummer der tragbaren Medien (für einige

Anwendungen mit einem Kopierschutzschlüssel

benötigt)

• Plug & Play-Dienst

• Ereignisprotokoll

• Kryptografiedienste
27



So deaktivieren Sie Elemente für den Systemstart:

1 Wählen Sie im Startmenü die Option

„Ausführen“, geben Sie „msconfig“ ein und

drücken Sie die Eingabetaste, um das

Dienstprogramm zur Systemkonfiguration

aufzurufen.

2 Wählen Sie auf der Registerkarte Allgemein die

Option Benutzerdefinierter Systemstart.

3 Deaktivieren Sie Systemstartelemente laden

und klicken Sie auf OK.

4 Klicken Sie auf Neu starten, um den Computer

neu zu starten.

5 Nach dem Neustart wird eine Meldung zur

Systemkonfiguration angezeigt. Starten Sie

Pro Tools und überprüfen Sie, ob die Leistung

verbessert wurde, bevor Sie die Option „Diese

Meldung nicht mehr anzeigen“ aktivieren. Hat

sich die Leistung nicht verbessert, führen Sie

„msconfig“ erneut aus und setzen Sie die

Einstellung „Systemstartauswahl“ Ihres

Computers wieder auf Normaler Systemstart -

Alle Gerätetreiber und Dienste laden.

Anfertigen von 
Sicherheitskopien
Nach der Konfiguration Ihres Systems und der

Installation von Pro Tools sollten Sie mit einem

Backup-Programm ein Image des Systems erstellen.

Auf diese Weise können Sie die Systemkonfiguration

und -einstellungen bei Problemen schnell

wiederherstellen.
Installieren der Pro Tools | Software
 28



Instalación del software Pro Tools | Software
Te damos la bienvenida a Pro Tools® | Software de

Avid. En esta guía se explican los procesos de

instalación y autorización del software Pro Tools en

sistemas Mac y Windows. Para obtener información

detallada sobre cómo configurar tu sistema Pro Tools e

información completa sobre sus posibilidades,

características y funciones, consulta la Guía de
referencia de Pro Tools (disponible en el menú

Help de Pro Tools).

Hay tres tipos de sistemas Pro Tools:

Pro Tools HD

El software Pro Tools HD se puede utilizar con el

siguiente hardware:

• Pro Tools | HDX para más entradas y salidas,

monitorización de baja latencia, y procesamiento

DSP dedicado para configuraciones con plug-ins

y grandes superficies de mezcla.

• Pro Tools | HD Native para más entradas y

salidas y monitorización de baja latencia

• Hardware de la familia Avid 003™, Eleven®

Rack, Mbox® (3.a generación) y Fast Track

• Equipos de audio de otros fabricantes con drivers

compatibles con Core Audio (Mac) o ASIO

(Windows), incluido el audio incorporado de los

ordenadores Mac

Pro Tools

El software Pro Tools se puede utilizar con los

siguientes equipos:

• Hardware de la familia Avid 003, Eleven Rack,

Mbox (3.a generación) y Fast Track
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• Equipos de audio de otros fabricantes con drivers

compatibles con Core Audio (Mac) o ASIO

(Windows), incluido el audio incorporado de los

ordenadores Mac

Requisitos y compatibilidad 
del sistema
Se necesita lo siguiente para instalar y autorizar el
software Pro Tools:

• Una unidad de DVD (si has adquirido una versión
en caja de Pro Tools con un disco de instalación)

• Una conexión de Internet (para descargar el
instalador de Pro Tools y la autorización de uso)

Se necesita lo siguiente para ejecutar el software
Pro Tools:

• Ordenador Macintosh o Windows homologado

• Una interfaz de audio homologada (o audio
incorporado)

• Una llave USB iLok (de 2.ª generación) para
autorizar el programa Pro Tools

Avid solo puede asegurar la compatibilidad y
proporcionar asistencia relativa al hardware y al
software probado y homologado por Avid. Para
ver listas completas de requisitos de sistema,
ordenadores homologados, sistemas operativos,
discos duros y dispositivos de otras marcas, visita
www.avid.com/compatibility.

Para obtener una lista de ordenadores e
interfaces de audio homologados para todos
los sistemas Pro Tools, visita
www.avid.com/compatibility.
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Acerca de iLok
El software Pro Tools se autoriza con una llave
USB iLok de 2.ª generación, provista por PACE
Anti-Piracy. Una de estas llaves puede contener
cientos de autorizaciones para todo el software que
utiliza iLok. En cuanto hayas almacenado la
licencia de un determinado software en la llave
iLok, podrás utilizarla para autorizar dicho
programa en cualquier ordenador.

• Si has adquirido una versión en caja de
Pro Tools, o hardware Avid con una versión de
Pro Tools o Pro Tools HD, incluye una llave
USB iLok (2.ª generación) y una tarjeta de
activación con un código de activación impreso.

• Si estás actualizando una versión previa del
software Pro Tools o Pro Tools HD, deberás usar
tu propia llave USB iLok USB (que debe ser de
2.ª generación). Recibirás un código de
activación en tu cuenta Avid online.

Requisitos de MIDI
Los interfaces MIDI USB, FireWire y PCI

funcionan correctamente con sistemas Pro Tools en

equipos Mac o Windows.

Requisitos de disco duro
Para grabar y reproducir audio de forma óptima, los

sistemas Pro Tools requieren uno o varios discos

duros homologados.

Procura no grabar en la unidad del 
sistema

Es posible grabar en la unidad del sistema, aunque

no se recomienda. Grabar y reproducir en la unidad

del sistema puede disminuir el número de pistas y

de plug-ins que pueden utilizarse.

Llave USB iLok (2.ª generación)
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Descripción general de la 
instalación
La instalación de Pro Tools implica los pasos

siguientes:

1 “Crear tu cuenta Avid” en la página 30.

2 “Descargar la licencia para

Pro Tools | Software” en la página 31.

3 “Eliminar versiones anteriores de

Pro Tools | Software” en la página 31.

4 “Instalación de drivers de hardware” en la

página 31.

5 “Instalar el programa Pro Tools | Software” en

la página 31.

6 “Encendido y apagado del sistema” en la

página 32.

7 “Ejecución y autorización de

Pro Tools | Software” en la página 33.

8 Configuración del sistema para obtener un

rendimiento mejorado.

Crear tu cuenta Avid
Se requiere una cuenta Avid para activar el

programa Pro Tools y, si has adquirido una versión

descargable, para descargarla.

 Si no tienes una cuenta Avid, visita

www.avid.com/myavid para crearla.

Para un rendimiento óptimo, es posible que
desees designar la unidad del sistema como
volumen de solo reproducción o solo
transferencia en el espacio de trabajo de
Pro Tools. Para obtener más información,
consulta la Guía de referencia de Pro Tools.
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Descargar la licencia para 
Pro Tools | Software
Al adquirir Pro Tools, recibes un código de

activación, ya sea en una tarjeta de activación o en

tu cuenta Avid.

Descargar la licencia para Pro Tools

1 Si no tienes una cuenta de iLok.com, visita

www.iLok.com y créala.

2 Visita www.avid.com/activation e inicia sesión

en tu cuenta Avid (si todavía no tienes una

cuenta, haz clic en “Crear su cuenta”).

3 Introduce tu código de activación y tu ID de

usuario de iLok.com.

4 Sigue las instrucciones en pantalla para

depositar tu licencia en tu cuenta de iLok.com.

Eliminar versiones anteriores 
de Pro Tools | Software
Si tienes instalada una versión anterior de

Pro Tools, elimínala según las instrucciones en la

Guía de Instalación de esa versión.

Instalación de drivers de 
hardware
Antes de instalar el software Pro Tools, instala los

drivers más recientes para tu hardware. Consulta la

documentación del equipo para obtener más

información. Si se trata de interfaces de audio

Avid, descarga e instala los drivers

correspondientes de www.avid.com/drivers.

Es posible tener instalado Pro Tools 10.3.6 o
superior conjuntamente con Pro Tools 11. Visit
www.avid.com/compatibility o consulta el
archivo Read Me de Pro Tools para más datos.
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Instalar el programa 
Pro Tools | Software
Cuando hayas instalado los drivers para tu interface

de audio, podrás instalar Pro Tools.

Instalación de Pro Tools en 
sistemas Mac

Para instalar Pro Tools en un sistema Mac:

1 Efectúa uno de estos procedimientos:

• Inserta el disco de instalación de Pro Tools en la

unidad de DVD.

• Descarga el instalador Pro Tools de tu cuenta

Avid online.

2 Abre el disco de Pro Tools o una imagen de

disco.

3 Instale Pro Tools 11.3.pkg haciendo doble clic.

4 Siga las instrucciones en pantalla para continuar

con la instalación.

5 Al finalizar la instalación, haga clic en Cerrar.

Pro Tools no reconocerá tu interfaz de audio
si no instalas los drivers. Si estás actualizando
Pro Tools, asegúrate de instalar los drivers
más recientes para tu hardware.

Antes de instalar Pro Tools, consulta el
archivo Pro Tools Read Me incluido con el
instalador.
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Instalación de Pro Tools en 
sistemas Windows

Para instalar Pro Tools en Windows:

1 Inicia sesión como administrador en la cuenta

donde desees instalar Pro Tools.

2 Lleva a cabo uno de estos procedimientos:

• Inserta el disco de instalación de Pro Tools en la

unidad de DVD.

• Descarga el instalador Pro Tools de tu cuenta

Avid online.

3 Lleva a cabo uno de estos procedimientos:

• Si está activada la opción Ejecución automática

de Windows, aparecerá un pequeño explorador.

Selecciona Install Pro Tools para iniciar la

instalación.

• Si está deshabilitada la Ejecución automática de

Windows, haz doble clic en Setup.exe y

selecciona Install Pro Tools para iniciar la

instalación.

4 Sigue las instrucciones en pantalla para

continuar con la instalación.

5 Al finalizar el Asistente de Instalación, haga clic

en Finalizar.

En Windows, si se abre el cuadro de diálogo
Control de cuentas de usuario, haz clic en
Permitir. Durante la instalación aparecerán
varios mensajes que se pueden pasar por alto,
como varios cuadros de diálogo sobre hardware
nuevo encontrado y sobre problemas durante la
instalación del hardware. Si aparece una
ventana que indica que el driver no supera la
prueba del logotipo de Windows, continúa de
todos modos.
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Encendido y apagado del 
sistema
Para que haya una correcta comunicación entre los
componentes del sistema Pro Tools, es preciso
seguir un orden de inicio concreto.

Inicia el sistema Pro Tools en este orden:

1 Asegúrate de que todos los componentes
(incluido el ordenador) estén apagados.

2 Baja el volumen de todos los dispositivos de
salida del sistema.

3 En los sistemas con un chasis de expansión,
enciende primero el chasis.

4 Enciende los discos duros externos. Espera diez
segundos para que alcancen la velocidad de
funcionamiento.

5 Enciende las superficies de control.

6 Enciende los interfaces y los dispositivos MIDI,
o los periféricos de sincronización.

7 En el caso de sistemas que necesitan
alimentación externa, enciende el equipo (por
ejemplo, HD I/O o 003). Espera al menos quince
segundos para que el interface de audio se inicie
y los indicadores LED de estado dejen de
parpadear.

8 Enciende el ordenador.

9 Inicia Pro Tools (consulta “Ejecución y
autorización de Pro Tools | Software” en la
página 33).

Apaga el sistema Pro Tools en este orden:

1 Sal de Pro Tools (en Mac: Pro Tools › Quit, o en
Windows: File › Exit).

2 Apaga o baja el volumen de todos los
dispositivos de salida del sistema.

3 Apaga el ordenador.

4 En los sistemas con hardware que requiere
alimentación externa, apaga el hardware.

5 Apaga los interfaces de audio de Pro Tools.

6 En los sistemas con un chasis de expansión,
apaga el chasis.
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7 Apaga los interfaces y los dispositivos MIDI, o
los periféricos de sincronización.

8 Apaga cualquier superficie de control o de
trabajo.

9 Apaga los discos duros externos.

Ejecución y autorización de 
Pro Tools | Software
Para ejecutar y autorizar el programa Pro Tools:

1 Comprueba que el interface de audio esté

conectado al ordenador y encendido.

2 Verifica que tu llave iLok (2.ª generación) esté

conectada a un puerto USB disponible en tu PC.

3 Lleva a cabo uno de estos procedimientos:

• En Mac, haz doble clic en el icono de la

aplicación en Macintosh

HD/Applications/Pro Tools.

• En Windows, haz doble clic en el acceso directo

a Pro Tools en el escritorio (o en la aplicación en

Archivos de programa\Avid\Pro Tools).

4 Cuando aparezca la pantalla de activación de

Pro Tools, haz clic en Activate.

5 Inicia sesión en tu cuenta de iLok.com. (Si no

tienes una cuenta de iLok, haz clic en Create

New Account.)

6 Cuando aparezca la lista de licencias disponibles,

selecciona la licencia de Pro Tools 11 y haz clic en

Next.

7 Selecciona tu iLok como la ubicación de la

licencia y haz clic en Next.

8 Después de completar la activación, haz clic en

Continue para iniciar Pro Tools.

No extraigas la iLok mientras inicias o
ejecutas Pro Tools.
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Configuración del sistema 
Pro Tools
Cuando hayas instalado, autorizado e iniciado el

software Pro Tools, podrás configurar el sistema

Pro Tools según las necesidades específicas de tu

estudio. Para obtener más información sobre la

configuración del sistema Pro Tools, consulta la

Guía de referencia de Pro Tools (disponible en el

menú de ayuda en Pro Tools).

Optimización de un sistema 
Mac para 
Pro Tools | Software
Para garantizar el óptimo funcionamiento con

Pro Tools, antes de usar el software Pro Tools,

configura el ordenador.

Antes de configurar el ordenador, inicia sesión como

administrador en la cuenta donde desees instalar

Pro Tools. Para obtener información sobre los

privilegios de administrador en Mac OS X,

consulta la documentación de Apple OS X.

Desactivación del economizador

Para desactivar la función de economizador:

1 Elige Preferencias del Sistema en el menú

Apple.

2 Haz clic en Economizador.

Para una lista completa de optimizaciones
recomendadas para tu sistema operativo, visita
www.avid.com/optimize.

No utilices la función de actualización
automática del software de Mac OS X, ya que
podría actualizar el sistema con una versión de
Mac OS que aún no se haya homologado para
Pro Tools. Para obtener más información
sobre las versiones homologadas de Mac OS,
visita www.avid.com/compatibility.
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3 Configura la opción Reposo del ordenador en

Nunca.

4 Configura la opción Reposo del ordenador en

Nunca.

5 Anula la selección de la opción Poner el disco

en reposo cuando sea posible.

Desactivación o reasignación de los 
atajos de teclado de Mac que se utilizan 
en Pro Tools

Para poder utilizar todos los métodos abreviados de

teclado de Pro Tools, debes desactivar o reasignar

en las preferencias del sistema de Apple los

métodos abreviados de teclado de Mac OS X que

entren en conflicto con el software.

Desactivación o reasignación de los atajos de

teclado de Mac que se utilizan en Pro Tools:

1 En el menú Apple, selecciona Preferencias del

Sistema.

2 Haz clic en Teclado y ratón.

3 Haz clic en la pestaña Funciones rápidas de

teclado.

4 Puedes deshabilitar o reasignar los atajos de
teclado que entren en conflicto con los de
Pro Tools. La siguiente lista incorpora varios
atajos de teclados comunes que, según cual sea
el modelo de tu Mac, también Introducción a
Pro Tools se pueden usar en Pro Tools:

• En “Launchpad y Dock”

• “Ocultar y mostrar el Dock automáticamente”

• En “Mission Control”

• “Mission Control”

• “Ventanas de aplicación”

• “Mostrar escritorio”

• “Mostrar Dashboard”

Para ver una lista completa de los métodos
abreviados de teclado de Pro Tools, consulta
la Guía de métodos abreviados de teclado
(Help › Pro Tools Shortcuts).
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• “Mission Control › Mover a la izquierda un

espacio”

• “Mission Control › Mover a la derecha un

espacio”

• “Mission Control › Pasar al Escritorio n”

• En “Teclado y entrada de texto”

• “Activar/Desactivar acceso por teclado”

• “Mover el enfoque al cajón de la ventana”

• “Mover el foco al Dock”

• “Mover el foco a la ventana activa o a la

próxima ventana”

• En “Servicios”

• “Enviar archivo a dispositivo Bluetooth”

• “Buscar con Google”

• “Spotlight”

• En “Spotlight”

• “Mostrar el campo de búsqueda de Spotlight”

• “Mostrar la ventana de Spotlight”

• En “Accesibilidad”

• “Zoom”

• “Contraste”

• En “Atajos de aplicaciones”

• “Mostrar el menú Ayuda”

Activación del registro para las 
unidades de audio

Para conseguir un mejor rendimiento con unidades

de audio, activa la función de registro.

Para activar la función de registro:

1 Inicia la aplicación Utilidad de disco, ubicada en

Aplicaciones/Utilidades.

2 En la columna izquierda de la ventana Utilidad

de disco, selecciona el volumen.

3 En la barra de herramientas, selecciona Activar

registro.
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Optimización de un sistema 
Windows para 
Pro Tools | Software
Para asegurar un rendimiento óptimo con

Pro Tools, configura el ordenador antes de utilizar

el hardware y el software Pro Tools.

Antes de configurar el ordenador, inicia sesión como

administrador en la cuenta donde desees instalar

Pro Tools. Para obtener más información al

respecto, consulta la documentación de Windows.

Optimizaciones obligatorias

Para asegurar un rendimiento óptimo con

Pro Tools, configura los parámetros siguientes

antes de utilizar el hardware y el software

Pro Tools.

Desactivación del Control de cuentas 
de usuario
Para desactivar el Control de cuentas de usuario:

1 Elige Inicio › Panel de control.

2 Haz clic en Cuentas de usuario y protección

infantil.

3 Haz clic en Cuentas de usuario.

4 Haz clic en Cambiar configuración de Control de

cuentas de usuario.

5 Coloca el control deslizante en No notificar

nunca.

6 Haz clic en Aceptar.

Para una lista completa de optimizaciones
recomendadas para tu sistema operativo, visita
www.avid.com/optimize.

Cuando hayas terminado de cambiar la
configuración del sistema Windows, reinicia
el ordenador.
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Configuración de inactividad del 
sistema y administración de energía

Cuando utilices Pro Tools, establece la opción de
energía en modo de espera de Windows en Siempre
activo. De este modo, se evita que se detengan los
pases de grabación y reproducción prolongados
porque el sistema entra en el modo de ahorro de
nergía.

Para configurar Administración de energía de

Windows:

1 Elige Inicio › Panel de control.

2 Haz clic en Sistema y seguridad.

3 Haz clic en Opciones de energía.

4 Haz clic en la flecha para Mostrar planes

adicionales.

5 Selecciona Alto rendimiento.

6 Haz clic en Cambiar la configuración del plan.

7 Haz clic en Cambiar la configuración avanzada

de energía.

8 En el cuadro de diálogo Opciones de energía,
abre Disco duro › Apagar disco duro tras.

9 Haz clic en la opción Configuración.

10 Selecciona el valor en el campo Configuración
(minutos) y pulsa la tecla Retroceso en el
tecladoo lleva el valor a Nunca.

11 Haz clic en Aceptar. La configuración del disco
duro cambia a Nunca y se cierra el cuadro de
diálogo Opciones de energía.

12 En la ventana Editar la configuración del plan,
haz clic en Guardar cambios y cierra la ventana.

Pro Tools cambia automáticamente a la opción
de administración de energía “Alto
rendimiento” al iniciarse. Windows regresa a la
opción de administración de energía
seleccionada anteriormente (si la hubiere) al
salir de Pro Tools. Por consiguiente, al optimizar
la opción de administración de energía para
Pro Tools, siempre se debería optimizar
únicamente la configuración de Alto
rendimiento.
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Optimizaciones recomendadas
Otros drivers de hardware y software que estén

instalados en el ordenador también pueden afectar

a Pro Tools. Para obtener un rendimiento óptimo,

se recomienda (aunque no es imprescindible) que

hagas lo siguiente:

• Evita la ejecución simultánea de otros programas

innecesarios al mismo tiempo que Pro Tools.

• Cierra las utilidades de software que se ejecuten

en segundo plano, por ejemplo, Windows

Messenger, calendarios y programas de

mantenimiento de discos.

• Mientras utilizas Pro Tools, apaga todos los

dispositivos USB que no sean imprescindibles.

Optimizaciones opcionales
Las siguientes optimizaciones pueden contribuir a

un mejor funcionamiento de Pro Tools en algunos

sistemas. Se recomienda usar estas optimizaciones

solamente cuando sea necesario, ya que pueden

desactivar otros programas del sistema o repercutir

negativamente en su funcionamiento.

Ajuste de la programación del 
procesador

Para ajustar el rendimiento de la programación del

procesador:

1 Haz clic con el botón derecho del ratón en Mi PC

y selecciona Propiedades.

2 Haz clic en Configuración avanzada del

sistema.

3 En el área Rendimiento, haz clic en el botón

Configuración.

4 En la ventana Opciones de rendimiento, haz clic

en la pestaña Opciones avanzadas.

5 En Programación del procesador, selecciona

Servicios en segundo plano.
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6 Haz clic en Aceptar para cerrar la ventana
Opciones de rendimiento.

7 Haz clic en Aceptar para cerrar la ventana
Propiedades del sistema.

Desactivación de los elementos de 
inicio del sistema

Cuantos menos elementos utilice el ordenador, más
recursos habrá disponibles para Pro Tools. Algunas
aplicaciones que se inician automáticamente al
arrancar el sistema pueden estar consumiendo
recursos de la CPU innecesariamente y pueden
desactivarse.

Ten cuidado si desactivas alguno de los elementos
de inicio siguientes:

• Número de serie de medio portátil (necesario
para algunas aplicaciones que utilizan una clave
de protección anticopia)

• Servicio Plug and Play

• Registro de eventos

• Servicios de cifrado

Para desactivar los elementos de inicio del

sistema:

1 En el menú Inicio, escribe “msconfig” en
Ejecutar y haz clic en Aceptar para abrir la
Utilidad de configuración del sistema.

2 En la pestaña General, elige Inicio selectivo.

3 Anula la selección de Cargar elementos de inicio

y haz clic en Aceptar.

4 Haz clic en Reiniciar para volver a iniciar el
ordenador.

5 Tras reiniciar, el ordenador mostrará un mensaje
de configuración del sistema. Comprueba si ha
mejorado el rendimiento de Pro Tools antes de
anular la selección de la casilla “No volver a
mostrar este mensaje”. Si no se observa mejora
alguna en el rendimiento, ejecuta “msconfig” y
vuelve a establecer Selección de inicio en Inicio
normal: cargar todos los drivers de dispositivo y
servicios. También puedes desactivar los
elementos de inicio y los procesos que no sean
imprescindibles de uno en uno.
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Copias de seguridad del 
sistema
Tras configurar el sistema e instalar Pro Tools,
debes guardar una imagen de la unidad del sistema
con una utilidad de copia de seguridad. De este
modo, podrás restaurar rápidamente la
configuración del sistema en caso de producirse
algún problema.
Instalación del software Pro Tools | Software
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3 Keyboard Shortcuts

4 Pro Tools
Mac OS

Mac Mac
Pro Tools | Software

Pro Tools

• Launchpad & Dock Launchpad Dock

• Turn Dock Hiding On/Off / Dock

• Mission Control

• Mission Control

• Application windows

• Show Desktop

• Show Dashboard Dashboard

• Mission Control > Move left a space Mission
Control >

• Mission Control > Move right a space

Mission Control >

• Mission Control > Switch to Desktop n

Mission Control > n

• Keyboard & Text Input

• Turn keyboard access on or off

• Move focus to the window drawer

• Move focus to the Dock Dock

• Move Focus to active or next window
Pro Tools
• Services

• Send File To Bluetooth Device

• Search With Google Google

• Spotlight

• Spotlight

• Show Spotlight search field Spotlight

• Show Spotlight window Spotlight

• Accessibility

• Zoom

• Contrast

• Application Shortcuts

• Show Help menu “ ”

1 Applications/Utilities Disk Utility

2 Disk Utility

3 Enable Journaling
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 Pro Tools  Windows

Pro Tools
Pro Tools

Pro Tools
Windows

Pro Tools
Pro Tools

(UAC)

1 Start > Control Panel >

2 User Accounts and Family Safety

3 User Accounts

4 Change User Account Control settings

5 Never Notify

6 OK

Pro Tools Windows System Standby
Always On

Windows

1 Start > Control Panel >

2 System and Security

3 Power Options

4 Additional Plans

www.avid.com/optimize

Windows
Pro Tools
5 High Performance

6 Change plan settings

7 Change advanced power settings

8 Power Options
Hard disk > Turn off hard disk after >

9 Setting

10 Setting (Minutes) [ ]
Backspace

Never

11 OK Never

Power Options

12 Edit Plan Settings
Save changes

Pro Tools

• Pro Tools

•
Windows Messenger

• Pro Tools USB

Pro Tools

Pro Tools High

Performance

Pro Tools Windows

Pro Tools

High Performance
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1 Computer Properties

2 Advanced system settings

3 Performance Settings

4 Performance Options
Advanced

5 Processor Scheduling
Background Services

6 OK Performance Options

7 OK System Properties

Pro Tools

CPU

•

•

•

•

1 Start Start Search
msconfig Enter System

Configuration Utility

2 General Selective

Startup

3 Load Startup Items

OK

4 Restart
Pro Tools
5 System
Configuration Don't
show this message again

Pro Tools
msconfig

Startup Selection Normal
Startup - load all device drives and services

-

Pro Tools
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Avid
280 N Bernardo Avenue
Mountain View, CA 94043 USA
Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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